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Transition to ArcGIS Pro (WVAGP) 

Open ArcGIS Pro Project 

First, you will need to download then open the provided ArcGIS Pro project.  

 Open ArcGIS Pro. This can be done by navigating to All Apps followed by the ArcGIS 

Folder. Within the ArcGIS Folder, select ArcGIS Pro. Note that you can also use a Task 

Bar or Desktop shortcut if they are available on your machine.  

 After ArcGIS Pro launches, select “Open another project.” 

 Navigate to the directory that houses the material for this course. This will be provided by 

your instructor. Find the Transition_to_Pro.aprx file and click on it to open the project. 

 Alternatively, you can navigate to the folder containing the Transition_to_Pro.aprx file 

and double-click to open the file and launch ArcGIS Pro.  

 In order to complete the sections that require ArcGIS Online, you will need to log in with 

a valid ArcGIS Online account. You can switch accounts using the options at the upper-

right corner of the software window.  

Task 1: Add Data from a Server  

 Navigate to the WV map.  

 

 Navigate to the Insert Tab. Under Connections, select New 

ArcGIS Server.  

 Enter the following URL: services.wvgis.wvu.edu/ArcGIS/services. Make sure 

to maintain http://. You do not need to provide a user’s name and password. 

Click OK.  

 Navigate back to the Map Tab. Click on the Add Data Button. Click on Servers 

followed by ArcGIS on services.wvgis.wvu.edu (user).ags. 
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 Navigate to the Imagery_BaseMaps_EarthCover 

folder.  

 Click on wv_imagery_NAIP_2016_1m. Click 

OK. 

The statewide aerial imagery should now be added to your map.  

Task 2: Change Data Symbology 

This is an example for symbolizing the counties based on the percentage of the population over 

55 years old.  

 Navigate to the Indiana Map.  

 Right-click on the Indiana layer in 

the Contents Pane followed by 

Symbology. This will load the 

Symbology Pane. 

 Change the Primary Symbology 

method to Graduated Colors.  

 Change the field to per_gt55. 

 Pick an appropriate color ramp.  

 If you’d like, you can change the classification method and number of classes. You can 

also change the labels by editing the Label column.  
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Task 3: Configure a Pop-Up 

This example will describe how to configure a pop-up.  

 Right-click on the Indiana layer in the 

Contents Pane. This will open the Pop-

Ups Pane.  

 Click on the box containing {STATE}. 

Change this to {COUNTY}. 

 Click on the pencil in the fields box.  

 Deselect all fields accept County Name, 

FIPS Code, Population Density, 

Percent Over 55, Median Income, and 

Percent Poverty. Navigate back to the 

Pop-Up Pane.  

 Click on Chart. Click on the pencil in 

the added chart box.  

 Change the type to Pie Chart. Change 

the title to “Election Results.” Select 

the per_dem, per_rep, and per_other 

fields. Navigate back to the Pop-Up 

Pane.  

 Close the Pop-Up Pane.  

 

 

 

 

 

 

 

 

 Click on a county in the map space to test the 

pop-up. 
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Tasks 4 and 5: Create a Map Layout 

The following text provides some advice on creating map layouts using ArcGIS Pro. These 

examples can be applied to your two map design tasks.  

Tip 1: Editing and Manipulating Layer Symbology 

In ArcGIS Pro, it is best to prepare your layer symbology in the map before adding the map 

frame to a map layout. As a review, you can change the layer symbology by right-clicking on the 

layer in the Contents Pane and selecting Symbology. This will open the Symbology Pane. Within 

this Pane, you can change many features of the symbology. 

 You can change the symbology. For 

example, you could display a polygon 

vector layer using the same color for 

each feature or you could produce a 

choropleth map, in which values or 

quantities from an attribute column 

are symbolized using different colors. 

You could also choose to show 

quantities using graduated or 

proportional symbols. For categorical 

data, you can display different 

categories using unique colors.  
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 If you used a classified legend, you can 

change the classification method (Natural 

Break, Quantiles, Equal Interval, Standard 

Deviation, Manual, etc.), the number of 

classes, and the color scheme.  

 

 In the label column in the table, you can 

change the label used for each category or classification bin by simply typing into the 

table.  The label will be used in the Contents Pane and in the map layout, including the 

legend. 

 Clicking on the symbols in the symbol column will open the Format Symbol Pane and 

allow you to edit the symbol, such as the color, outline color, and outline width.  

Raster data layer symbology can also be 

changed using the Symbology Pane. For 

example, the symbology of a continuous 

raster can be altered from a stretched to a 

classified symbology.  

 

 

The color scheme used to symbolize raster 

data can also be changed in the Symbology 

Pane. You can also edit the legend labels.  
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You can also apply a color to symbolize NoData values.  

 

Using the Stretch Method, you can change the data range to be dynamic based on what values 

are in the current display extent. This can be done by setting the Statistics option to DRA 

(dynamic range adjustment using statistics from the current display extent). This can be useful 

when you want to use the full range of colors in the color scheme in the display extent.  
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Categorical raster data are generally 

symbolized using unique values, or a different 

color for each category. You can change the 

label and the color/symbol used to represent 

categories.  

You may find that the default symbology may 

not be optimal for your intended purpose. So, 

you will commonly need to manipulate 

symbology using the options available in the 

Symbology Pane.  

 

 

 

Tip 2: Changing Colors and Symbols 

You can change the symbol used to show points, lines, or polygons by double-clicking the 

symbology in the Contents Pane. This will open the Symbology Tab. You can then use the 

Gallery or Properties to change the symbology. The image below provides an example for a 

point layer. Here, we have searched for airport symbols.  
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Alternatively, right-clicking on the symbol for the 

layer in the Contents Pane will open a menu that 

allows you to change symbol properties.  

So, there are many ways to change the layer 

symbology. Again, we would encourage you to 

experiment with the options available.  

 

 

 

 

 

Tip 3: Changing Layer Transparency 

You may want to make one of your layers partially transparent. For example, the image below 

was created by making a digital elevation model (DEM) partially transparent and displaying it 

over a hillshade image.  
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To add transparency to a layer, use the transparency slider under 

the Appearance Tab. 

 

 

Tip 4: Creating a Layer File 

Once you have created a layer 

symbology that you find to be effective, 

you can save it to a Layer File. This can 

be done by right-clicking on the layer in 

the Contents Pane then selecting Save 

As Layer File.  

 

Note: You are not saving a copy of the data. Instead, you are saving a file that stores the 

symbology for later use.  

If you would like to apply the saved layer symbology to a new layer, this can be done in the 

Symbology Pane using the Import Option.  

 

We have found that layer files offer a very useful and efficient means for storing and saving data 

symbology for later use. For example, when you create a new data layer to share with a 

colleague you could also provide a layer file so that the data can by symbolized as you intend it 

to be symbolized.  
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Tip 5: Legend Design 

You should already know how to add a legend to a map. Here, we will discuss some means to 

further edit and enhance legends. Legends are very important components of maps, so it is 

important that you think about how the legend is presented.  

Once a legend has been added to the map layout it can be resized and 

moved by selecting it. Once selected, you can move and resize it using 

the selection box. The legend should always be intentionally placed.  

Under the Format Tab for the legend, you can alter the legend in many 

ways including: 

 Changing the fill and outline color. 

 Changing the font style, boldness, size, and color. 

 Changing the alignment of the legend. 

 Changing the position and size of the legend.  

 

You can also edit the legend by selecting it in the Contents Pane for the map layout. This should 

open the Format Legend Pane. In this pane, you can do the following: 

Under the Legend options: 

 Change the name of the legend as displayed in the 

Contents Pane. 

 Lock it or change the visibility of it on the layout. 

 Add and show a legend title. 

 Change how the legend is synchronized with the associated 

map. 
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Under the Text Symbol Options: 

 Change the text appearance. For example, you can 

change the font type, boldness, size, color, and case. 

You can also underline the text. 

 Change the text alignment, such as changing the 

horizontal and vertical alignment or applying offsets. 

 Rotate the text by a defined angle. 

 Add a halo to the text. 

 Add a shadow. 

 Add callouts.  

 

 

 

 

 

 

 

You can also change individual elements in a legend. Within the Contents Pane for the map 

layout, you can expand the legend element to see what features are 

included. If you click off a layer, it will no longer be shown in the 

legend. If you click a layer, the Format Legend Item Pane should 

open. This allows you to make changes to just this item in the 

legend, not the entire legend.  

For example, if you do not want to display the layer name or attribute heading for a layer in a 

legend, you can turn these features off in the Legend Items options. You can also change the 

arrangement of the legend elements. And the size of the symbology. Under the Text Symbols 

options, you can edit the text symbols as described above. 
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There are many options available for editing legends and individual legend elements. The best 

way to learn is to simply experiment with the options available.  

 

Tip 6: Inserting Graphics 

You can insert graphics, such as logos or graphs into a map layout. 

This is easy. To insert a graphic, navigate to the Insert Tab while the 

map layout is active and selected Picture in the Graphics Area. This 

will allow you to insert a graphic element from a file. Make sure 

that the graphic file you want to add is high enough resolution. You 

don’t want it to look blurry once the map layout has been produced.  

This menu also allows you to add additional map elements. For example, you can draw areal 

features (rectangles, circles, ellipses, and polygons), points, and lines. Once these features have 

been drawn, you can edit their appearance by clicking on them in the map space to open the 

associated formatting pane. For example, if you draw a rectangle, you can change the color, 

outline color, and outline size.   
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Tip 7: Editing Scale Bars 

Similar to editing legends, you can also edit elements of a scale bar. Once a scale bar has been 

added and while it is selected, you can navigate to the Format Tab to edit it. This tab allows you 

to: 

 Change the font type, boldness, size, and color. 

 Change the scale bar alignment and size.  

 Add a fill color. 

 Add an outline and change its width and color. 

 

The Design Tab allows you to further edit the scale bar. Here, you can change the following: 

 Resizing behavior  

 Number of divisions 

 Number of subdivision 

 Units of measurement 

 Placement of measurement units 

 How the measurement units are labelled (for example, miles vs mi) 

 The frequency of marks 

 The position of the marks 

 Frequency of numbers 

 Position of numbers 

 

You can also manipulate the legend by selecting it from the Contents Pane for the map layout. 

This will open the Format Scale Bar Pane. Again, the default settings may not be optimal, so you 

may need to use these tools and settings to manipulate the scale bar to meet your needs. Again, 

we encourage you to experiment with the available options.  

Tip 8: Creating Graticules and Coordinate Grids 

You can add a longitude and latitude reference (graticules) to a map frame on a layout. You can 

also add coordinate system grids (for example, a UTM grid). With the map frame of interest 

selected, navigate to the Insert Tab and click the 

dropdown arrow next to Grid in the Map Frame 

area. This will open a list of available grids.  

If you select the grid object in the Contents Pane, 

the Format Map Grid Pane will load.  
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Selecting one of these options will add it 

to the map frame.  
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The grid can be edited. It is listed in the Contents Pane under the map frame to which it has been 

added. You may have to expand the map frame in the Contents Pane to see the grid element. This 

menu provides a set of options for editing the elements associated with the grid. Some features 

that can be changed include the following: 

 The font type, size, boldness, and color of the labels 

 Where labels will be placed 

 The presentation of the coordinates (for example, 

degrees minutes and second or degrees and decimal 

degrees) 

 The interval of tick marks, labels, and grid lines 

We have found that the Components options offer the most 

efficient means to edit grids.  

 

Note: The projection used can have a large impact on the map layout and the patterns of the 

graticules or coordinate grid. It is important to think about what projection is appropriate for a 

map.  

 

Tip 9: Adding Multiple Data Frames and Inset Maps 

You may want to create a layout that contains more than one map frame. For example, you may 

want to add an inset map showing the location of your larger map within a broader geographic 

extent. You may want to add multiple maps to compare data or show change over time.  

The image to the right shows a layout in 

which an inset map has been added to show 

the extent of the larger map within a 

geographic area.  

 

 

 

 

This map provides an example of a layout in 

which one map frame has been duplicated to 

compare different outputs.  
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Adding multiple map frames to a layout is easy. Once the first frame is added, a 

second frame can be added by navigating back to the Insert Tab and selecting the 

dropdown arrow associated with the Map Frame Button. This will open a list of 

available maps within the project that can be added to the layout.  

Once frames have been added, they can be selected to change their position and size in the 

layout.  

If you want to pan or zoom the map within the 

map frame, you can right-click on it and make it 

active. 

Once you have navigated within the map space, 

you will need to close the active map frame.  

 

 

Tip 10: Inserting Extent Indicators 

In is possible to indicate the extent of one map frame within another map frame. For example, 

you could highlight the location of your main map on the inset map. This can be done by adding 

an extent indicator.  
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Extent indicators can be added by clicking on the Extent Indicator button within the Map Frame 

area of the Insert Tab when a layout is active. You will want to make sure the map frame to 

which you want the extent indicator to be added is selected. Using the dropdown arrow 

associated with the Extent Indicator button, you can select which 

map you want to indicate on the selected map. This will add an 

extent indicator.  

To edit the added extent indicator, you will need to find it in the 

Content Pane for the map layout. It will be listed under the map 

frame to which is has been added.  

Click on it in the Contents Pane will open the 

Format Extent Indicator Pane so that it can be 

edited.  

The map below provides an example of an extent 

indicator. The red rectangle on the smaller state 

map shows the extent of the larger map above it. 

Note that the extent indicator symbology was 

changed using the Format Extend Indicator Pane. 
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Tip 11: Editing and Removing Map Frame Borders 

You may want to edit or remove the border around a map frame. To do this, click on the map in 

the Contents Pane for the map layout. This should open the Format Map Frame Pane. Click on 

the dropdown arrow next to Map Frame then select border. This will provide Gallery and 

Properties options for changing the map frame border.  

 

Using the options available in the Format Map Frame Pane, you can also make changes to the 

map frame, background, and shadow. For example, you could add a shadow behind the frame. 

Again, it is worth taking some time to experiment with the options available.  

Tip 12: Improving Labelling 

There are many options for working 

with and manipulating labels. Here, we 

will just provide a brief introduction.  

 

First, it is easier to begin working with 

labels within a map as opposed to a 

map layout. So, you should navigate 

back to the map that contains the layer 

to which you are interested in applying 

labels. You will then need to click on 

the layer for which you want to add 

labels in the Contents Pane.  

Navigate to the Labeling Tab. This provides options for labeling features. Here are a few options 

available for labeling features: 

 Turn labels on  

 Pick an attribute column from which to obtain labels 

 Choose scales at which to show or not show labels 
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 Change the font type, size, boldness, and color of the labels 

 Make use of default label placement options 

Note: In ArcGIS Pro, the Mapplex Labeling Engine is used to label features. This engine takes 

into account rules and cartographic principles to label features.  

If you click on the arrow in the corner of the Text Symbol area of the Labeling Tab, this should 

open the Label Class Pane. This pane provides additional options for changing the text labels. 

You can also access this pane by right-clicking on the layer of interest in the Contents Pane and 

selecting Labeling Properties. 

 

This menu allows you to make changes to the label text using the Symbol options including the 

following: 

 Changing the font type, size, boldness, 

and color 

 Changing the positioning and alignment 

of the labels 

 Rotating the labels 

 Adding a halo 

 Adding a shadow 

 Adding a callout 

 

 

You can also edit the location and placement of 

the labels using the Position options. 

Labeling positioning can be a complex topic. We 

will not cover positioning in detail here. However, 

feel free to experiment with the positioning 

options.  
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Another topic that will not be covered here is using annotations. Under the Map Tab, you can use 

the Convert To Annotation button to convert labels to annotations. Annotations allow individual 

text elements to be edited and stored in a geodatabase. 

You may find that additional label editing may be required to obtain the desired results. Some of 

this editing may have to take place outside of ArcGIS Pro in vector graphics editing software, 

such as Adobe Illustrator. We will discuss how to export a file to a vector format for additional 

editing in a vector graphics editing software below. 

Tip 13: Convert to Graphic, Group, Ungroup 

Some map elements can be converted to graphics. They can then be edited like graphics. Here 

we will provide an example with a legend.  

To convert a map element into a graphic, simply right-click on it and select Convert to Graphics.  

 

Note: Once a map element has been converted to a graphic, it is no longer dynamic and will not 

automatically update as the map is changed. For example, if you convert a scale bar to a graphic 

then change the scale of the map, the legend scale bar will not update to reflect the new map 

scale. So, if you need to convert a map element to a graphic, you should not do this until your 

map layout is complete and you will no longer make changes to scale or symbology. 

Once a map element is converted to a graphic, its components can be ungrouped so that they can 

be moved and edited separately. This can be accomplished by right-clicking on the element of 

interest and selecting Ungroup. 

Below, is an example of the legend 

elements once they have been 

Ungrouped. 
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Again, the reason why you may choose to convert map elements to graphics and ungroup them is 

so that they can be edited like graphic elements. Clicking on the elements will open formatting 

panes to edit the characteristics of the object, such as the text.  

Once a graphic object has been ungrouped, it 

can be grouped again. This can be 

accomplished by selecting multiple objects, 

right-clicking, then selecting Group.  

 

Tip 14: Exporting to a Vector Format 

You may find that you need to do additional map editing in a vector graphics editing software, 

such as Adobe Illustrator or InkScape. To do this, you will need to export your map to a vector 

format that maintains the vector graphic components, such as text.  

To export to a vector format, navigate to the Share Tab. Click on the Layout button.  

You will then need to save the file in a vector format, such as EPS, PDF, SVG, or AI. 

This will allow for later editing in a vector graphics editing software.  

Tip 15: Locking Map Elements 

If you do not want to be able to further change map elements, they can be locked. This is useful 

if you want to make sure you do not accidentally alter a map element.  

To lock a map feature, simply click on the lock symbol next to it in the Contents Pane for the 

map layout. If you want to be able to edit it later, you can click on the lock again to unlock it.  

 

Lock  
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Task 6: Create a 3D Scene 

You will now create a 3D scene for the 

downtown area of Pittsburgh.  

 Navigate to the Pittsburgh map.  

 Navigate to the View Tab.  

 Click on the Convert Button and select To 

Local Scene. A new local scene should be 

generated. Navigate to this scene.  

 Click on the Pittsburgh_buildings layer in 

the Contents Pane. Navigate to the 

Appearance Tab. Within the Extrusion 

Tab, select Type followed by Max Height. Change the field to Max_M and make sure the 

Unit is set to meters.  

 Take some time to explore the 3D scene.  

 

You will now link the 3D scene to and the 2D scene of 

Pittsburgh.  

 To link the 2D map and 3D scene navigate to 

the View Tab then selection Link Views 

followed by Center and Scale.  

 You may need to move the map and scene 

windows to see them both at the same time.  

 Take some time to explore the linked 2D map 

and scene.  

 To de-link the map and scene, click on the Link 

View Button again under the View Tab.  
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Task 7: Publish Map to ArcGIS Online and Make an App 

You will now work through the process of publishing data from ArcGIS Pro to ArcGIS Online. 

You will then use this data to make a web map. Note that you will be provided with an ArcGIS 

Online account to complete this task.  

 Navigate to the To_Online map. 

 Navigate to The Share Tab.  

 Click on The Web Map Button. Note that 

you will have to be logged in to ArcGIS 

Online with your assigned account to 

publish the data.  

 In the Share As Web Map Pane do the 

following: 

o Change the Name to “Indiana 

County Median Income Data YOUR 

NAME.” 

o Add a summary and some tags.  

o Share the map with Everyone.  

 Click on Analyze to make sure there are no 

issues prior to publishing. No issues should 

be found. Warnings are okay. 

 Click Share to publish the map. This will 

take several minutes.  

 

 

 

 In a web browser, go to ArcGIS Online: https://www.arcgis.com/home/index.html. 

 Click Sign In and sign in with the credentials provided to you. 

 Once logged in, navigate to your Content Tab.  

 Your “Indiana County Median Income Data YOUR NAME” map should show up in your 

content list. Click on it to open the map. In the next window, select Open in Map Viewer.  

 

You now have a web map that is uploaded to ArcGIS Online. However, you still need to 

build a web app or webpage from it.  

 Click on the Share Button.  

 In the Share window, you should not have to make any changes. 

However, make sure that Everyone (public) and West Virginia University are selected.  

 Select CREATE A WEB APP. 

https://www.arcgis.com/home/index.html
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 In the Create a New Web App Window, select the Basic Viewer configurable app under 

Show All.  

 Once it is selected, click CREATE WEB APP. 

 

 Feel free to change the title, add additional tags, and add a summary. Select DONE. 

 Work through the General, Theme, Options, and Search tabs to make any changes that 

you desire. The only change you need to make is to add a Legend widget under the 

Options Tab. 

 When you are satisfied, selected Save followed by Launch to view your new app. 

 Take some time to review your app in the web browser.  
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Task 8: Join Table to Feature Class 

You will now perform a table join.  

 Navigate to the WV map.  

 Right-click on the counties_wv layer in the 

Contents Pane then select Joins and Relates 

followed by Add Join. This will open the Add 

Joins Tool. 

 Make the following changes in the Add Joins Tool: 

o Make sure the Layer Name or Table View is set to counties_wv. 

o Set the Input Join Field to NAME. 

o Set the Join Table to deer_harvest_2004b. 

o Set the Output Join Field to NAME2. 

o Make sure “Keep All Target Features” is selected.  

 Click Run to execute the tool. 

 Open the attribute table for the counties_wv layer to confirm that the fields were joined. 

Take some time to explore the data.  

 

 

Task 9: Selections 

First, let’s find all counties that contain limestone geology. 

 Navigate to the WV map.  

 Navigate to the Map Tab. 

 Click on Select By Attribute in the Selection area. This will open the Select Layer By 

Attribute Tool. 

 Make the following changes in the tool: 

o Make sure the Layer Name or Table View is set to geology_wv. 
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o Make sure the Selection type is set to New selection. 

o Add a clause as TYPE is Equal to limestone.  

 

 
 

 

 Click Run to execute the selection. 

 Click on Select by Location in the 

Selection area of the Map Tab. This 

will load the Select By Location Tool.  

 Make the following changes in the 

Select by Location Tool: 

o Make sure the Input Feature 

Layer is set to counties_wv 

o Make sure the Relationship is 

set to Intersect. 

o Set the Selecting Feature to 

geology_wv. 

o You do not need to change any 

other settings.  

o Click Run to execute the 

selection.  
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19 counties should be selected that contain some limestone geology. You can confirm this by 

opening the attribute table or by using the Selection View in the Contents Pane. 

You will now find all counties in West Virginia that contain an interstate and an airport.  

 Clear the previous selection by selecting Clear in the Selection area under the Map Tab.  

 Click on Select by Location in the Selection area of the Map Tab. This will load the 

Select By Location Tool. 

 Make the following changes in the Select by Location Tool: 

o Make sure the Input Feature 

Layer is set to counties_wv. 

o Make sure the Relationship is 

set to Intersect. 

o Set the Selecting Feature to 

interstates_wv. 

o You do not need to change any 

other settings.  

o Click Run to execute the 

selection.  

 

 

 

 Re-execute the Select by Location Tool with the following settings: 

o Make sure the Input Feature Layer is set to counties_wv. 

o Make sure the Relationship is set to Intersect. 

o Set the Selecting Feature to airports_wv. 

o Change the Selection type to “Select subset from the current selection.” 

o You do not need to change any other settings.  

o Click Run to execute the selection.  

19 counties should be selected that contain an interstate and an airport. You can confirm this by 

opening the attribute table or by using the Selection View in the Contents Pane. 

Task 10: Dissolve 

You will now run the Dissolve Tool to obtain the state boundary from the county boundaries. 

 Navigate to the WV map. 

 Navigate to the Analysis Tab. 

 Click on Tools in the Geoprocessing Area. 

 In the Geoprocessing Window, search for Dissolve.  

 Click on the Dissolve Tool in the search results. This should be the first result.  

 Make the following changes in the Dissolve Tool: 

o Set the Input Feature to counties_wv. 
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o You can change the name of the output if you like. 

o You do not need to set a Dissolve_Field(s) or make any additional changes.  

 Click Run to execute the tool.  

 

This tool should produce a state boundary from the county boundaries.  

Task 11: Reclassify Land Cover 

You will now reclassify the National Land Cover Database (NLCD) data to three class: Water, 

Forest, and Other.  

 Navigate to the WV map. 

 Navigate to the Analysis Tab. 

 Click on Tools in the Geoprocessing Area. 

 In the Geoprocessing Window, search for 

Reclassify.  

 Click on the Reclassify Tool in the search results. 

This should be the first result.  

 Make the following changes in the Reclassify 

Tool: 

o Set the Input Raster to nlcd_2011_wv. 

o Set the Reclass field to Land_Cover. 

o Provide the new values. Open Water 

should be coded to 1, the three forest 

types should be coded to 2 (Deciduous 

Forest, Evergreen Forest, and Mixed 

Forest), and all other categories should be 

coded to 3. 

o Name the Output. 

 Click Run to execute the tool.  

The new categorical grid should automatically be added to your WV map.  
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Task 12: Zonal Statistics as Table 

You will now determine which county in the state has the highest mean elevation using the Zonal 

Statistics as Table Tool.  

 Navigate to the WV map. 

 Navigate to the Analysis Tab. 

 Click on Tools in the Geoprocessing Area. 

 In the Geoprocessing Window, search for Zonal Statistics as Table.  

 Click on the Zonal Statistics as Tool in the search results. Do not use the Zonal Statistics 

Tool.  

 Make the following changes 

in the Zonal Statistics as 

Table Tool: 

o Set the Input Raster or 

Feature Zone Data to 

counties_wv. 

o Use NAME as the 

Zone Field. 

o Set the Input Value 

Raster to elev_wv. 

o Name the Output 

Table. 

o Set the Statistic Type 

to Mean. 

 Click Run to execute the tool.  

Explore the table output. Randolph County should have been identified as the county with the 

highest mean elevation.  

Task 13: Moran’s I 

You will now use the Moran’s I test to 

determine whether median income shows 

clustering, dispersion, or randomness when 

aggregated at the county level. 

 Navigate to the Indiana map. 

 Navigate to the Analysis Tab. 

 Click on Tools in the Geoprocessing 

Area. 

 In the Geoprocessing Window, search 

for Moran’s I. 

 Click on the Spatial Autocorrelation 

(Global Moran’s I) Tool in the search 

results.  
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 Make the following changes in the Spatial Autocorrelation (Global Moran’s I) Tool: 

o Set the Input Feature Class to Indiana. 

o Set the Input Field to Median Income.  

o Select Generate Report. 

o You do no not need to change any additional settings.  

 Click Run to execute the tool.  

 Once the tool executes, hover over the completion message. In the pop-up window, click 

on the Report File. It will open as an HTML page in the web browser.  

These results suggest that median income is clustered when aggregated at the county level. The 

Moran’s I Index was positive and the p-value was statistically significant.  
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Task 14: ModelBuilder 

In this final task, you will create a model to determine the area of palustrine wetlands that could 

be impacted by highway development. Before you begin the analysis, you will need to create a 

new toolbox in which to save your model. You will do so using ArcCatalog. 

 In ArcGIS Pro, navigate to the View Tab then select Catalog View. This will open the 

Catalog View if it is not already open.  

 In the Catalog View, double-click on Toolboxes. This will open a list of available 

toolboxes.  

 Right-click in the toolbox space within the Catalog View then select New Toolbox. 

Provide a name to save the new toolbox.  

Note: Each project has a default toolbox associated with it. You can use this toolbox. Here, we 

are having you create a new toolbox so that you know how to do so. Tools, such as models, must 

be saved inside of toolboxes. 

Step 1. Creating the Model 

 Navigate to the Analysis Tab then select ModelBuilder under the 

Geoprocessing area. This will open the ModelBuilder window.  

 In the ModelBuilder Tab, click on the Save As button. 

 Navigate to the toolbox you just created and save the model in the 

toolbox as wetland_tool.  

 

In this exercise, you will specifically focus on impacts to palustrine wetlands. So, impacted 

wetlands will be those that are within 1 km of the proposed highway and are palustrine.  

 

Here are the required steps: 

1. Buffer the proposed highway using a 1 km buffer distance. 

2. Select any wetlands that are palustrine and extract them from the larger dataset. 

3. Clip the palustrine wetland using the road buffer.  

4. Calculate the area of the wetland within a new field.  

5. Summarize the field to obtain the total area impacted. 

This section will guide you in creating the model. Once your model is complete, it should look 

like the model presented below.  
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First, change the environment settings for the ModelBuilder so that the outputs are automatically 

saved to the Transition_to_Pro.gdb geodatabase in your copy of the course folder.  

 In the ModelBuilder Tab and in the Model area, select the 

Environments button.   

 Set the Current Workspace and the Scratch Workspace to the 

Transition_to_Pro.gdb geodatabase.  

 Click OK to save these environment settings. 

Note: Environment settings changed within ModelBuilder are only honored by operations 

performed within the model, not by all operations performed within the project. 

 Add the two input layers to the model by dragging them from the Contents Pane to 

the model area. 

There are many options for adding tools to the model.  

 Right-click on the Tools button under ModelBuilder. This will open the 

Geoprocessing Pane. In the Geoprocessing Pane, click on Toolboxes to view 

ArcToolbox. Tools can be added by dragging them from ArcToolbox to the model 

area.  

 Add the following tools to the model.  

 

1. Buffer Tool (This can be found in the Proximity subtoolbox of the Analysis Toolbox.) 

2. Select Tool (This can be found in the Extract subtoolbox of the Analysis Toolbox.) 

3. Clip Tool (This can be found in the Extract subtoolbox of the Analysis Toolbox.) 

4. Add Geometry Attributes Tool (This can be found in in the Features subtoolbox of the 

Data Management Toolbox.) 

5. Summary Statistics Tool (This can be found in the Statistics subtoolbox of the Analysis 

Toolbox.) 

You will now need to specify the settings for each tool. The outputs will automatically save to 

the Transition_to_Pro.gdb geodatabase, as this was defined as the working directory. To edit the 

settings for each tool, click on each tool to open up the wizard. Once you have specified the 

desired settings, click OK to accept the changes. Note that links between inputs and tools and 

tools and outputs will be created as you change the settings.  

 Specify the settings for all tools. 

Buffer 

 Input Features = TuckerCounty_CorridorH 

 Output Feature Class = Road_Buffer 

 Linear Units = Kilometers 

 Distance = 1 

 You do not need to change any other settings.  
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Select 

 Input Features = wetlands 

 Output Feature Class = palustrine_wetlands 

 Clause 

o Field = WET_TYPE 

o Operator = “Begins With” 

o Values = P 

Note: This will extract all records in which the wetland type begins with the letter P. This will be 

all of the palustrine wetlands.  

Clip 

 Input Features = palustrine_wetlands 

 Clip Features = Road_Buffer 

 Output Feature Class = wetland_clip 

 You do not need to change any of the other settings.  

Add Geometry Attributes 

 Input Features = wetland_clip 

 Geometry Properties = Area 

 Area Units = Acres 

 Coordinate System = Current map [Map] (should be NAD 1983 UTM Zone 17 

North) 

 You do not need to change any of the other settings.  

Summary Statistics 

 Input Table = wetland_clip(2) 

 Output Table = total_area 

 Statistics Fields 

o Field = “POLY_AREA” 

o Statistic Type = “SUM” 

 You do not need to change any of the other settings.  

You should now have a completed model that looks like the one shown above.  

 Save your model by clicking on the Save button in the Model area of the 

ModelBuilder Tab.  

 

Note: You can make your model graphic a little neater by using the Auto Layout 

button. This can be used to make the graphic more orderly. Blue indicates inputs, 

yellow indicates tools or processes, and green indicates outputs.  

 



34 
 

Step 2. Execute the Model 

 

Now that you have a complete model, it can be executed. Before you execute the model it is 

generally a good idea to validate the model.  

 

 Click on the Validate Tool in the Run area of the ModelBuilder Tab to 

validate the model. If no issues are flagged, no issues were detected.  

 You can now run your model. Do this by clicking the Run Button in the 

Run area of the ModelBuilder Tab.  

 

 Once the model executes, no layers will be added to your map. You will need to add the 

wetland_clip(2) and the total_area outputs to the map to answer the questions below. To 

do this, right-click on the output model graphic then select Add to Display. 

 

Use the results to answer the following questions.  

What is the name of the attribute column that holds your calculated total area measurement in the 

total_area table? 

What is the total acreage of wetlands impacted by the road construction? 

What is the name of the attribute column that holds your calculated area for each wetland in the 

wetland_clip(2) layer? 

What is the largest acreage of a single wetland impacted by the road construction? 

 

Step 3. Creating a Tool from a Model 

 

Models can be used like other tools made available in ArcToolbox. However, this does require 

some additional work. Let’s start by adding your new toolbox that contains the model you just 

created.  

 Save your model again by clicking on the Save button in the Model area 

of the ModelBuilder Tab.  

 Close the ModelBuilder window.  

 Navigate to the Catalog Tab followed by Toolboxes. 

 Locate the toolbox that contains the model you created.  
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 If you double-click on the added toolbox, the contents will be displayed. It should just 

contain your model.  

 

 Double-click on the model to open it as a tool. Note that it opens in the 

Geoprocessing Pane. However, it only says No Parameters. 

 

Why can’t you specify any settings? This is because you did not specify any user-defined 

parameters. You will need to do so if you want someone to use your model as a tool and not 

interact with it directly. We will now guide you through that process. 

 Close the Geoprocessing Pane. 

 Back in the Contents Pane, right-click on the model then select Edit. This will open 

the model so that it can be edited using ModelBuilder. 

 
You will begin by setting the input highway as a parameter and giving it a more meaningful 

name.  

 Right-click on the blue circle that says 

TuckerCounty_CooridorH.  

 Select Parameter.  

 Next, select Rename and change the name to 

“Proposed Highway.” Do not include the 

quotes here or in any of the steps below.  
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 Using similar methods, define the wetlands input as a parameter and change the name 

to “Wetlands Features” and set it as a parameter. 

 Using similar methods, change the wetland_clip(2) output name to “Impacted 

Wetlands 2.”  Do not define it as a parameter.  

 Change the name of the final output, total area, to “Output Table” and make it a 

parameter.  

 Change the name of the buffer output to “Buffer Output” and make it a parameter. 

 Change the name of the select output to “Palustrine Wetlands” and make it a 

parameter. 

This tool would be much more robust if you could change the buffer distance. Luckily, you can 

specify this as a user-defined parameter also.  

 Right-click on the Buffer Tool in the model. Select Create Variable followed by From 

Parameter. Select Distance [value or field]. 

 

 Right-click on this new variable then select Parameter to add it as a user-defined 

parameter.   
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 Click Save in the Model area of the ModelBuilder Tab to save these changes.  

 Close the model. 

 Return to the Catalog Tab. Double-click on Toolboxes followed by your toolbox.  

 Double-click on your model to open it in the Geoprocessing Pane.  

Now, your model has parameters that can be specified by the user. So, the end-user can use this 

like any other ArcToolbox tool. He or she does not need to interact with the model directly.  

 Change the distance to 2 kilometers and re-execute the tool. You will also need to 

rename the outputs. 

 

Note: If you do not change the names of the outputs the original outputs will be overwritten. 

That is why there are warning symbols next to these parameters. If the outputs are loaded into 

your map, the tool will fail as the files cannot be overwritten. 

Use the results to answer the following questions.  
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What is the largest acreage of a single wetland impacted by the road construction using a buffer 

distance of 2 kilometers?  

What is the total acreage of wetlands impacted by the road construction using a buffer distance 

of 2 kilometers?  

What is the difference in total acreage between the area of impact defined using the 2 kilometer 

buffer vs. using the 1 km buffer? 

Step 4. Rename Tool  

 

You can give the tool a more meaningful name using the Properties Button in the Model area 

under the ModelBuilder Tab. Alternatively, this can be done within the Catalog Pane. Here, we 

will demonstrate the Catalog Pane.  

 Navigate to the Catalog Pane followed by Toolboxes.  

 Right-click on the model within your new toolbox. Select Properties. 

 

From this menu, you can give the tool a more descriptive name by changing the label.  

 Change the label to rename the tool.  

You will have to select Save from the Model area under the ModelBuilder Tab to complete the 

label change.  

 


